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 AN4495
 MPLAB® Harmony v3 项目移植

简介

MPLAB® Harmony v3 是一个模块化框架，能够提供可互操作的固件库来支持基于 32 位单片机和微处理器的应用程序

开发。它包括易于使用的图形用户界面（Graphical User Interface，GUI）、MPLAB 代码配置器（MPLAB Code
Configurator，MCC）或 MPLAB Harmony 配置器（MPLAB Harmony Configurator，MHC），可用于选择、配置、生

成代码、外设库、驱动程序和大量中间件（例如，USB、TCP/IP 和图形）。

本文档探讨了如何将在特定硬件（单片机或开发板）平台上开发的基于 MPLAB Harmony v3 的现有项目移植到用户选

择的其他 Microchip 32 位硬件平台。

注：在本文档中，短语代码生成工具指代以下两款 Microchip 代码生成工具之一：MPLAB 代码配置器（MCC）和

MPLAB Harmony 配置器（MHC）。在本文档发布之时，MPLAB Harmony v3 库代码可以使用上述工具中的任意一款

来生成。但在将来，只有 MCC 支持 MPLAB Harmony v3 代码生成。
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1. 概述
通常，在嵌入式产品的应用程序项目开发中，首先需要使用现有的参考资料。Microchip 为客户提供了参考应用程序

演示（包含在 MPLAB Harmony v3 软件包中），以供其在开发项目时参考。这些 MPLAB Harmony v3 项目是在

Microchip 的开发板（例如 32 位 SAM 或 PIC32 单片机（MCU）的开发板）上开发的。用户可以从这些应用程序演示

着手，然后将其移植到所选的硬件平台上。

本文档介绍了如何在以下场景中移植在 Microchip 开发板或工具包上开发的 MPLAB Harmony v3 应用程序演示项目。

• 场景 1：增强或定制现有应用程序演示

• 场景 2：移植到定制板（搭载具有相同器件 ID 的 MCU）

• 场景 3：移植到同系列中具有不同器件 ID 的 MCU
• 场景 4：移植到其他 MCU 系列中具有不同器件 ID 但处理器内核相同的 MCU

注：

1. 下图分别给出了一些采用 Arm® Cortex®和 MIPS®内核架构的 32 位单片机产品系列。有关 Microchip 32 位单片

机系列的更多信息，请访问 https://www.microchip.com/en-us/products/microcontrollers-and-
microprocessors/32-bit-mcus。
图 1-1. 32 位单片机系列

2. Arm Cortex 和 MIPS32 内核架构下的每个产品系列都提供有多个具有不同特性的 MCU 器件，例如 PIC32MX 系

列包含 PIC32MX250F128B、PIC32MX470F512L 和 PIC32MX795F512L 等。

3. 如上所述，场景 3 和场景 4 分别对应的是同系列器件间的移植和跨系列器件间的移植，但两种情况下的内核架

构都没有发生变化。

4. 此外，还有一种可能的场景（场景 5），即用户希望将在基于 MIPS 的 MCU 上开发的应用程序移植到基于 Arm
Cortex 的 MCU 上，或反之。本文档并未涵盖这一场景，因为在处理器架构完全不同的情况下，建议从头开始

创建项目，不要尝试移植。

https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/32-bit-mcus
https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/32-bit-mcus
https://www.microchip.com/en-us/product/PIC32MX250F128B
https://www.microchip.com/en-us/product/PIC32MX470F512L
https://www.microchip.com/en-us/product/PIC32MX795F512L
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2. 移植组件
在以下章节中，使用 MPLAB Harmony v3 项目在 SAM D21 Xplained Pro 评估工具包上开发的 SD 卡和 USB 数据记录

器应用程序作为参考，并将其称为“参考项目”。

2.1 MPLAB X IDE 项目
移植时需要考虑的 MPLAB X IDE 项目配置参数如下。

1. 位置：项目根文件夹的路径。

2. 文件夹名称：.X文件夹的名称。

图 2-1. 项目文件夹名称

3. 名称：项目的逻辑名称，位于 MPLAB X IDE 项目资源管理器中。

图 2-2. MPLAB X 项目名称

4. 配置名称：MPLAB X IDE 中的一项功能，支持平台或目标器件特定的编译和编程。

https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/samd21_sdcard_usb_datalogger.zip
https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/samd21_sdcard_usb_datalogger.zip
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图 2-3. MPLAB X 项目配置名称

5. 目标器件：项目开发使用的 MCU 器件 ID。

6. 支持包：器件系列包（Device Family Package，DFP）包含用于访问目标 MCU 外设寄存器的宏定义。在 Arm
Cortex 器件上，CMSIS 包也包含在内。

7. 编译器工具链：该项显示编译器工具链及其版本。

8. 编程或调试工具：用于对 MCU 进行调试或编程的硬件工具。

9. 编译选项：用于优化源代码的编译器编译选项及任何其他选项。

10. 链接器选项：堆、堆栈存储器和其他相关参数的默认设置。

11. 编译前或编译后脚本：指定必须在项目编译之前或之后运行的任何脚本或命令行。

12. 源文件和库文件参考：MPLAB Harmony v3 生成的及用户添加的源文件、头文件和库文件的相对路径。

图 2-4. MPLAB X 项目属性

5

8

6

7

9

11

12

10

MPLAB X IDE 配置参数保存在 MPLAB X IDE 项目文件夹下的 configurations.xml文件中。参考项目位于

samd21_sdcard_usb_datalogger\firmware\sam_d21_xpro.X\nbproject 中。
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• 对于场景 1，可以使用在 Microchip 开发板或工具包上开发的现有 MPLAB Harmony v3 应用程序演示或对其进行

定制，以添加或删除 MPLAB Harmony v3 模块。现有 MPLAB X IDE 项目的配置参数已经足够，不需要更改。但

是，用户可以更改一些参数来适应最终应用。

– 要重命名 MPLAB X IDE 项目和文件夹名称，请在 MPLAB X IDE 中打开项目，右键单击项目名称，然后选

择 Rename（重命名）。

图 2-5. MPLAB X 项目重命名

– 要重命名 MPLAB X IDE 配置参数，请参见技术简介《如何向现有的 MPLAB Harmony v3 项目添加新配

置》。对于场景 1，在 MPLAB Harmony v3 中重命名配置实际上会创建一个新的 MPLAB X IDE 项目，因此

不建议重命名配置。

– 步骤 5 到步骤 12 列出的其他 MPLAB X IDE 参数可以通过图 2.4 所示的 Project Properties（项目属性）窗

口进行更改或修改。

• 有关场景 2、3 和 4 中的 MCU 器件 ID，请参见文档《如何向现有的 MPLAB Harmony v3 项目添加新配置》的添

加新配置一节下的在 MPLAB X IDE 中创建项目小节，然后遵循该文档中给出的详细信息进行操作。确保提供上

述步骤 1 到步骤 12 中列出的所需 MPLAB X IDE 配置参数，特别是目标器件 ID。

http://www.microchip.com.cn/newcommunity/Uploads/202203/623938d2d9a1b.pdf
http://www.microchip.com.cn/newcommunity/Uploads/202203/623938d2d9a1b.pdf
http://www.microchip.com.cn/newcommunity/Uploads/202203/623938d2d9a1b.pdf
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2.2 工具配置
MCC 或 MHC 工具会将项目图中使用的所有组件的配置保存在各自单独的文件中。此外，还支持导入和导出这些配

置。

将选定组件的配置保存到外部文件的操作称为导出。导入则是读取保存在外部文件中的一个组件或一组组件的外部配
置，然后将该配置添加到当前项目中。

MCC 工具配置文件.mc3位于 MPLAB X IDE 项目文件夹中。对于参考项目，该文件的保存位置如下：

samd21_sdcard_usb_datalogger\firmware\sam_d21_xpro.X。

MHC 工具配置文件位于 MHC 文件夹中。对于参考项目，该文件的保存位置如下：

samd21_sdcard_usb_datalogger\firmware\src\config\sam_d21_xpro\sam_d21_xpro.mhc。

导入功能对于上文给出的移植场景很有用。

启动 MCC：

1. 在 MPLAB X IDE 中打开参考项目。

2. 要启动 MCC，转至 Tools > Embedded > MPLAB Code Configurator v4（工具 > 已安装工具 > MPLAB 代码配

置器 v4）。

启动 MHC：

1. 在 MPLAB X IDE 中打开参考项目。

2. 要启动 MHC，转至 Tools > Embedded > MPLAB Harmony 3 Configurator（工具 > 已安装工具 > MPLAB
Harmony 3 配置器）。

图 2-6. 启动 MCC 或 MHC

例如，如果用户想要使用参考项目中的以下配置，则可以使用 MCC 或 MHC 工具中的导出和导入功能将这些配置添加

到新项目中：

• SD 卡 SPI 驱动程序

• 文件系统服务

• MSD 功能驱动程序

• SPI 驱动程序

• SERCOM PLIB
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图 2-7. 参考项目配置

导入和导出 MHC

请按照以下步骤导入和导出 MHC：

1. 在 MHC 中，选择 File > Export（文件 > 导出）。

2. 在 Export Configuration（导出配置）对话框中，选中所需的组件。

3. 指定保存导出文件的路径，然后单击 Export（导出）以导出选中的组件配置，如下图所示。
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图 2-8. MHC 导出

4. 在新的 MHC 项目中，选择 File > Import（文件 > 导入）以重定向到导出文件的保存路径。

5. 选择要导出的文件，然后单击 Open（打开）。
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图 2-9. MHC 导入

6. 通过从.mhc文件夹中一次选择一个.yml文件，用户还可以导入单个配置。

图 2-10. 在 MHC 上导入单个配置

注：用户也可以直接使用参考项目源文件的.mhc文件夹下保存的外设配置文件（.yml）导入。
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图 2-11. 使用.mhc 文件夹下保存的外设配置文件导入

导入或导出 MCC

请按照以下步骤导入和导出 MCC：

1. 在 MPLAB X IDE 中，单击 Resource Management (MCC)（资源管理（MCC））。

2. 单击 Project Resources（项目资源）选项卡，然后展开库。

3. 右键单击所需的组件，然后选择 Mark for config export（标记为配置导出）。

图 2-12. 在 MCC 上标记为导出
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4. 对于所有其余组件，如外设中的 SERCOM0、驱动程序中的串行外设接口（Serial Peripheral Interface，
SPI）、系统服务中的文件系统和 USB 器件协议栈库中的大容量存储设备（Mass Storage Device，MSD）功能

驱动程序，请按照上述步骤完成操作。

5. 将全部所需组件标记为导出后，单击 Export。
图 2-13. 在 MCC 上导出

6. 指定导出文件.mc3的保存路径，然后单击 Save（保存）。

图 2-14. 保存导出文件

7. 在 MPLAB X IDE 中，在新项目中选择 Resource Management (MCC) > Import（资源管理（MCC）> 导入）以

重定向到导出文件.mc3所在的路径。

8. 选择导出文件，然后单击 Open。
图 2-15. MCC 导入
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2.3 时钟
在移植嵌入式应用程序项目时，CPU 时钟和基于 CPU 时钟生成的外设时钟是基本要素。

对于场景 1 和 2，由于 MCU 器件 ID 保持不变，因此 CPU 时钟也将保持不变。在这两种场景中，MPLAB Harmony v3
演示应用程序中配置的现有时钟即可用于用户应用程序。如果需要，用户也可以更改时钟。

对于场景 3，虽然同一个器件系列的时钟模块可能相同，但目标 MCU 的时钟速度可能不同。这一变化意味着必须更改

目标 MCU 的时钟。用户需要验证时钟设置并根据需要进行更改。

对于场景 4，运行现有 MPLAB Harmony v3 演示应用程序的 MCU 极有可能与要移植到的 MCU 器件 ID 使用不同的时

钟模块。这意味着需要更改目标 MCU 的时钟。用户需要验证时钟设置并根据需要进行更改。

参考项目中的 CPU 时钟配置如下图所示：

图 2-16. 参考项目 CPU 时钟设置



 AN4495
移植组件

© 2022 Microchip Technology Inc.
及其子公司

 应用笔记 DS00004495A_CN-第 14 页

在下图中，将 CPU 时钟源从 DFLL 更改为内部振荡器 8 MHz（OSC8M），并禁止 DFLL 时钟源。

图 2-17. 更改 CPU 时钟源
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2.4 外设库
MPLAB Harmony v3 外设库（Peripheral Library，PLIB）提供了一个硬件抽象层（Hardware Abstraction Layer，
HAL）接口，用于访问 MCU 上的外设。PLIB 应用程序接口（Application Program Interface，API）隐藏了外设寄存器

的详细信息，通过调用 PLIB API 可更加轻松地根据应用程序要求配置外设。

PLIB 可添加到项目中并通过代码生成工具（MCC 或 MHC）项目图进行配置。

• 对于场景 1，在添加、删除、修改或保留现有 PLIB 时，没有特殊注意事项。启动代码生成工具（MCC 或 MHC）

项目图，执行任意一项上述操作，然后生成代码。例如，下图所示的操作为将新 PLIB 添加到参考项目中。用户必

须配置每个新添加的外设。

图 2-18. 添加新 PLIB

• 对于场景 2、3 和 4
– 确保从现有 MPLAB Harmony v3 应用程序演示中导入所需的代码生成工具（MCC 或 MHC）配置。有关更

多信息，请参见工具配置。

– 对于在 MPLAB Harmony v3 应用程序演示中添加的 PLIB，用户必须验证在定制板或用户板中连接的外设。

假设使用不同的外设或同一外设的不同实例。在这种情况下，必须更新代码生成工具（MCC 或 MHC）的

PLIB 模块和项目图，并且需要重新生成项目。

例如，如果在定制板中使用 SERCOM2 而非 SERCOM3 作为 UART 调试接口，则必须通过在参考项目图中

删除 SERCOM3 并添加 SERCOM2 来更新 SERCOM 模块，如下图所示。用户必须配置每个新添加的外

设。
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图 2-19. 现有的 UART 调试 SERCOM 实例

图 2-20. 更新后的 UART 调试 SERCOM 实例
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• 如果用户更改了项目图中使用的 PLIB，则在应用程序调用 PLIB API 时，所做的更改必须体现在 API 调用中。例

如，如果更改了 UART 调试接口，项目图中的 PLIB 模块将从 SERCOM3 更改为 SERCOM2，则在以下 API 中也

必须进行相同的更改：

– 将应用程序代码中的 SERCOM3_USART_Write API 替换为 SERCOM2_USART_Write。
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2.5 端口引脚
SAM 和 PIC32 MCU 上的端口引脚具有多路复用功能，这意味着跟踪可用或已分配的引脚并决定将 I/O 引脚分配给指

定的外设可能比较有难度。如果要将项目从一个平台移植到另一个平台，难度更高。

代码生成工具（MCC 或 MHC）提供了 Pin Configuration（引脚配置）窗口，可在其中配置或重新配置端口引脚。

• 对于场景 1，如果通过添加或删除 PLIB 来添加或删除新的引脚功能，则可以通过 Pin Configuration 窗口中的代码

生成工具（MCC 或 MHC）执行相应引脚的配置。例如，下图显示了场景 1 中在 PLIB 中添加的 PLIB 配置引脚。

图 2-21. 配置引脚以添加新 PLIB

• 对于场景 2、3 和 4：
– 确保从现有 MPLAB Harmony v3 应用程序演示中导入所需的代码生成工具（MCC 或 MHC）配置。有关更

多信息，请参见工具配置。

– 对于在 MPLAB Harmony v3 应用程序演示中添加的 PLIB，用户必须验证在定制板或用户板中连接的外设。

如果使用不同的外设或同一外设的不同实例，还需要在代码生成工具（MCC 或 MHC）的 Pin Configuration
窗口中验证和更新外设的引脚，并且将需要重新生成项目。

例如，如果在使用不同 UART 引脚的定制板中使用 SERCOM2 而非 SERCOM3 作为 UART 调试接口，则必

须在参考项目图中重新配置调试 UART 引脚，如下图所示。

图 2-22. 现有 SERCOM 实例引脚配置

图 2-23. 将现有 SERCOM3 实例引脚重新配置为可用
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图 2-24. 为更新后的调试 SERCOM2 实例重新配置引脚
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2.6 驱动程序
MPLAB Harmony v3 驱动程序是一个接口，用于控制、访问及管理 32 位 SAM 和 PIC32 单片机上的外设和其他资源。

此驱动程序接口允许应用程序和其他客户端模块（驱动程序、中间件库和系统服务）与外设交互。

下图给出了 MPLAB Harmony v3 架构，其中显示了 PLIB 和驱动程序的位置。PLIB 可直接访问硬件，其中驱动程序在

PLIB 的基础之上编译并为其他 MPLAB Harmony v3 软件组件（插件、中间件和系统服务）和应用程序提供了抽象化

接口。

图 2-25. MPLAB Harmony v3 架构

Softw
are Fram
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• 对于场景 1，在添加、删除、修改或保留现有驱动程序时，没有特殊注意事项。启动代码生成工具（MCC 或

MHC）项目图，执行任意一项上述操作，然后生成代码。例如，如果参考项目有使用 USART 与外部器件交互的

额外要求，可向参考项目中添加一个 USART 驱动程序，同时 SERCOM1 用作底层外设模块，如下图所示。

图 2-26. 添加驱动程序

• 应用程序将使用以下 API 将数据传输到外部器件：

DRV_USART_WriteBufferAdd(appData.usartHandle, (void*)messageBuffer,
strlen(messageBuffer), &appData.bufferHandle);

• 对于场景 2、3 和 4：
– 确保从现有 MPLAB Harmony v3 应用程序演示中导入所需的代码生成工具（MCC 或 MHC）配置。有关更

多信息，请参见工具配置。

– 驱动程序为 MCU 外设提供了一个抽象的接口，因此在将项目从一个平台移植到另一个平台时，无需更改用

户应用程序中使用的驱动程序 API 调用。但是，编译驱动程序时使用的底层 PLIB 必须按照 PLIB 和端口引脚

中的说明进行移植。
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图 2-27. 具有不同 PLIB 模块的驱动程序

项目图中的 USART 模块发生上述更改（如图 2-8 MHC 导出所示）时，不需要对调用 USART 驱动程序 API
的应用程序进行任何更改。

DRV_USART_WriteBufferAdd(appData.usartHandle, (void*)messageBuffer,
strlen(messageBuffer), &appData.bufferHandle);

2.7 系统服务
MPLAB Harmony v3 提供了不同驱动程序、中间件或应用程序所需的通用功能。它通过保持底层请求分离来管理共享

资源并消除潜在的资源冲突。MPLAB Harmony v3 架构显示了系统服务在 MPLAB Harmony 架构中的位置。

• 对于场景 1，在添加、删除、修改或保留现有系统服务时，没有特殊注意事项。启动代码生成工具（MCC 或

MHC）项目图，执行任意一项上述操作，然后生成代码。

例如，如果参考项目有使用控制台系统服务的额外要求，可向参考项目中添加控制台系统服务，如下图所示。

图 2-28. 添加控制台系统服务并配置 SYS_DEBUG

• 对于场景 2、3 和 4：
– 确保从现有 MPLAB Harmony v3 应用程序演示中导入所需的代码生成工具（MCC 或 MHC）配置。有关更

多信息，请参见工具配置。
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– 与驱动程序相似，系统服务为共享资源提供了一个抽象的接口。在将项目从一个平台移植到另一个平台时，

无需更改用户应用程序中使用的系统服务 API 调用。但是，编译系统服务时使用的底层资源（PLIB 和驱动

程序）必须按照驱动程序、PLIB 和端口引脚中的说明进行移植。

例如，在参考项目中，文件系统服务使用 SDSPI 驱动程序，该驱动程序使用 SPI 驱动程序，而后者又使用

SERCOM0（SPI）PLIB。

图 2-29. 文件系统服务和相关模块

在上图中，更改 SERCOM0 PLIB 时不需要更改应用程序代码，这是因为 API 提供了一个抽象的接口，应用

程序可使用文件系统服务 API 来处理传感器数据。

2.8 中间件
MPLAB Harmony v3 为复杂的协议和技术（例如 USB、TCP/IP、音频和加密）提供了中间件库。中间件使用驱动程序

和系统服务。MPLAB Harmony v3 架构显示了中间件在 MPLAB Harmony 架构中的位置。

• 对于场景 1，在添加、删除、修改或保留现有系统服务时，没有特殊注意事项。启动代码生成工具（MCC 或

MHC）项目图，执行任意一项上述操作，然后生成代码。例如，如果参考项目有使用 USB CDC 类的额外要求，

可向参考项目中添加一个 USB CDC 类，如下图所示。
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图 2-30. 添加 USB CDC 类

• 对于场景 2、3 和 4：
– 确保从现有 MPLAB Harmony v3 应用程序演示中导入所需的代码生成工具（MCC 或 MHC）配置。有关更

多信息，请参见工具配置。

– 与驱动程序和系统服务相似，中间件也提供了一个抽象的接口。在将项目从一个平台移植到另一个平台时，

无需更改用户应用程序中使用的中间件 API 调用。但是，编译系统服务时使用的底层资源（PLIB、驱动程序

和系统服务）必须按照系统服务、驱动程序、PLIB 和端口引脚中的说明进行移植。
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2.9 应用程序
MPLAB Harmony v3 应用程序通常在 main.c和 app.c文件中开发。此外，这类应用程序文件还包含多种其他必需的

源文件、头文件或库文件。

• 对于场景 1，在添加、删除、修改或保留应用程序文件时，没有特殊注意事项。用户可以使用下图所示的 MPLAB
X IDE 功能将应用程序文件添加到现有项目中。

图 2-31. 添加应用程序源文件

同样，用户也可以添加应用程序头文件。
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图 2-32. 添加应用程序头文件

• 对于场景 2、3 和 4，可使用下列任一方法将应用程序文件从现有项目移植到新项目中。

– 方法 1. 添加现有项

在这种方法中，用户可以选择下图中突出显示的任一选项，将用户应用程序文件手动添加到新项目中。该方

法适用于向项目中添加的应用程序文件数量少于 10 个的情况。

图 2-33. 添加应用程序文件

• 方法 2. 从文件夹中添加现有项



 AN4495
移植组件

© 2022 Microchip Technology Inc.
及其子公司

 应用笔记 DS00004495A_CN-第 26 页

a. 如果添加到项目中的应用程序文件数量较多（超过 10 个或是多个目录和子目录下的多个文件），则这种方

法比较合适。
例如，需要将参考项目中的应用程序文件添加到 ATSAME51J20A MCU 上 MPLAB X IDE 项目文件夹名称

为 sam_e51_cnano.X的新项目中。

b. 从 src文件夹下的参考项目中复制所有必需的应用程序源文件（.C、.cpp和.h）（如有文件夹结构，也

一并复制），然后将其粘贴到用户创建的项目下的 src文件夹中。

c. 从参考项目的 MPLAB X IDE 项目文件夹 sam_d21_xpro.X\nbproject中复制 configurations.xml
文件，然后将其覆盖到用户项目文件夹 sam_e51_cnano.X\nbproject中。

d. 打开已覆盖的 configuration.xml文件，然后按照如下所述替换所有实例：

• 将现有项目配置名称更改为新项目配置名称：

将 sam_d21_xpro替换为 sam_e51_cnano。
• 将现有项目 MCU 器件编号更改为新项目 MCU 器件编号：

将 SAMD21J18A 替换为 SAME51J20A，将 D21/d21 替换为 E51/e51。

注：

1. 如果现有项目与新项目的 MCU 器件编号相同，则无需此更改。

2. 修改 configurations.xml文件可能会很棘手，因此在替换器件编号时必须小心谨慎，确保器件编号正确无

误。
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3. 参考资料
有关 Microchip 产品、供货情况和 MPLAB Harmony v3 的更多信息，请访问 Microchip 网站或联系当地的销售代表。

• MPLAB Harmony v3 Quick Docs 资源库为用户提供了独立的帮助页面，可帮助用户着手开发基于 Microchip 32
位 SAM 和 PIC32 MCU 的应用程序。从 docs 文件夹中的 index.html开始。

可访问以下位置获取在线版本：https://microchip-mplab-harmony.github.io/quick_docs/
• Harmony 主页面：

www.microchip.com/harmony
• 使用 MCC 创建新的 MPLAB Harmony v3 项目：

microchipdeveloper.com/harmony3:getting-started-training-module-using-mcc
• 将现有基于 MHC 的 MPLAB Harmony v3 项目更新和配置为基于 MCC 的项目：

microchipdeveloper.com/harmony3:update-and-configure-existing-mhc-proj-to-mcc-proj
• 《如何向现有的 MPLAB® Harmony v3 项目添加新配置》：

www.microchip.com.cn/newcommunity/Uploads/202203/623938d2d9a1b.pdf
• 《如何通过向现有的 MPLAB® Harmony v3 项目添加新的 PLIB、驱动程序或中间件来构建应用程序》：

www.microchip.com.cn/newcommunity/Uploads/202103/6064070d67eaa.pdf
• MPLAB Harmony v3 开发人员帮助页面：

microchipdeveloper.com/harmony3:start
• 有关导入/导出功能的 MHC 用户界面概述：

microchip-mplab-harmony.github.io/mhc/doc/readme_mhc_import_export.html

https://www.microchip.com/
https://microchip-mplab-harmony.github.io/quick_docs/
http://www.microchip.com/harmony
https://microchipdeveloper.com/harmony3:getting-started-training-module-using-mcc
https://microchipdeveloper.com/harmony3:update-and-configure-existing-mhc-proj-to-mcc-proj
http://www.microchip.com.cn/newcommunity/Uploads/202203/623938d2d9a1b.pdf
http://www.microchip.com.cn/newcommunity/Uploads/202103/6064070d67eaa.pdf
https://microchipdeveloper.com/harmony3:start
https://microchip-mplab-harmony.github.io/mhc/doc/readme_mhc_import_export.html
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Microchip 网站

Microchip 网站（www.microchip.com）为客户提供在线支持。客户可通过该网站方便地获取文件和信息。我们的网站

提供以下内容：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新的软件版
本以及归档软件

• 一般技术支持——常见问题解答（FAQ）、技术支持请求、在线讨论组以及 Microchip 设计伙伴计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip 销售办事

处、代理商以及工厂代表列表

产品变更通知服务

Microchip 的产品变更通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的某个产品系列

或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请访问 www.microchip.com/pcn，然后按照注册说明进行操作。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（ESE）
• 技术支持

客户应联系其代理商、代表或 ESE 寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售办事处的联系

方式。

也可通过 www.microchip.com/support 获得网上技术支持。

Microchip 器件代码保护功能

请注意以下有关 Microchip 产品代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术规范。

• Microchip 确信：在正常使用且符合工作规范的情况下，Microchip 系列产品非常安全。

• Microchip 注重并积极保护其知识产权。严禁任何试图破坏 Microchip 产品代码保护功能的行为，这种行为可能会

违反《数字千年版权法案》（Digital Millennium Copyright Act）。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是“牢不可破”

的。代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。

法律声明

提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关 Microchip 产品性能和

使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主管与员工及事务代理机构对译文中可

能存在的任何差错不承担任何责任。建议参考 Microchip Technology Inc.的英文原版文档。

本出版物及其提供的信息仅适用于 Microchip 产品，包括设计、测试以及将 Microchip 产品集成到您的应用中。以其他

任何方式使用这些信息都将被视为违反条款。本出版物中的器件应用信息仅为您提供便利，将来可能会发生更新。如

需额外的支持，请联系当地的 Microchip 销售办事处，或访问 https://www.microchip.com/en-us/support/design-help/
client-supportservices。

http://www.microchip.com
http://www.microchip.com/pcn
http://www.microchip.com/support
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Microchip“按原样”提供这些信息。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其他形式的声明

或担保，包括但不限于针对非侵权性、适销性和特定用途的适用性的暗示担保，或针对其使用情况、质量或性能的担

保。

在任何情况下，对于因这些信息或使用这些信息而产生的任何间接的、特殊的、惩罚性的、偶然的或间接的损失、损

害或任何类型的开销，Microchip 概不承担任何责任，即使 Microchip 已被告知可能发生损害或损害可以预见。在法律

允许的最大范围内，对于因这些信息或使用这些信息而产生的所有索赔，Microchip 在任何情况下所承担的全部责任均

不超出您为获得这些信息向 Microchip 直接支付的金额（如有）。如果将 Microchip 器件用于生命维持和/或生命安全应

用，一切风险由买方自负。买方同意在由此引发任何一切损害、索赔、诉讼或费用时，会维护和保障 Microchip 免于承

担法律责任。除非另外声明，在 Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可证。
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电话：86-769-8702-9880
中国 - 广州

电话：86-20-8755-8029
中国 - 杭州

电话：86-571-8792-8115
中国 - 香港特别行政区

电话：852-2943-5100
中国 - 南京

电话：86-25-8473-2460
中国 - 青岛

电话：86-532-8502-7355
中国 - 上海

电话：86-21-3326-8000
中国 - 沈阳

电话：86-24-2334-2829
中国 - 深圳

电话：86-755-8864-2200
中国 - 苏州

电话：86-186-6233-1526
中国 - 武汉

电话：86-27-5980-5300
中国 - 西安

电话：86-29-8833-7252
中国 - 厦门

电话：86-592-2388138
中国 - 珠海

电话：86-756-3210040

印度 - 班加罗尔

电话：91-80-3090-4444
印度 - 新德里

电话：91-11-4160-8631
印度 - 浦那

电话：91-20-4121-0141
日本 - 大阪

电话：81-6-6152-7160
日本 - 东京

电话：81-3-6880-3770
韩国 - 大邱

电话：82-53-744-4301
韩国 - 首尔

电话：82-2-554-7200
马来西亚 - 吉隆坡

电话：60-3-7651-7906
马来西亚 - 槟榔屿

电话：60-4-227-8870
菲律宾 - 马尼拉

电话：63-2-634-9065
新加坡

电话：65-6334-8870
台湾地区 - 新竹

电话：886-3-577-8366
台湾地区 - 高雄

电话：886-7-213-7830
台湾地区 - 台北

电话：886-2-2508-8600
泰国 - 曼谷

电话：66-2-694-1351
越南 - 胡志明市

电话：84-28-5448-2100

奥地利 - 韦尔斯

电话：43-7242-2244-39
传真：43-7242-2244-393
丹麦 - 哥本哈根

电话：45-4485-5910
传真：45-4485-2829
芬兰 - 埃斯波

电话：358-9-4520-820
法国 - 巴黎

电话：33-1-69-53-63-20
传真：33-1-69-30-90-79
德国 - 加兴

电话：49-8931-9700
德国 - 哈恩

电话：49-2129-3766400
德国 - 海尔布隆

电话：49-7131-72400
德国 - 卡尔斯鲁厄

电话：49-721-625370
德国 - 慕尼黑

电话：49-89-627-144-0
传真：49-89-627-144-44
德国 - 罗森海姆

电话：49-8031-354-560
以色列 - 若那那市

电话：972-9-744-7705
意大利 - 米兰

电话：39-0331-742611
传真：39-0331-466781
意大利 - 帕多瓦

电话：39-049-7625286
荷兰 - 德卢内市

电话：31-416-690399
传真：31-416-690340
挪威 - 特隆赫姆

电话：47-72884388
波兰 - 华沙

电话：48-22-3325737
罗马尼亚 - 布加勒斯特

电话：40-21-407-87-50
西班牙 - 马德里

电话：34-91-708-08-90
传真：34-91-708-08-91
瑞典 - 哥德堡

电话：46-31-704-60-40
瑞典 - 斯德哥尔摩

电话：46-8-5090-4654
英国 - 沃金厄姆

电话：44-118-921-5800
传真：44-118-921-5820

http://www.microchip.com/support
http://www.microchip.com
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